Graphical Data Reprsentation
By Dr. Justin Bateh, Florida State College at Jacksonville &
Dr. Bert Wachsmuth, Seton Hall University

3.1 What is Graphical Data Representation
As we have seen in chapter 1, statistics is the study of making sense of data, and consists of four components: collecting, summarizing, analyzing, and presenting data. In this step we will concern ourselves with summarizing data.
Usually when data is collecting there is a lot of numbers, results, responses, etc. In fact, there is usually so much data that it needs to be summarized before it can be analyzed. One approach to summarizing data is to summarize it in graphical or tabular form. Since a picture is worth more than 10,000 words, we hope to be able to detect patterns or be able to draw conclusions once we see data presented graphically.
In this chapter we will discuss how to use Excel to create Pie and Bar Charts for categorical variables and Histograms for numerical variables. We will also show how charts can be used to emphasize different points of views without modifying or falsifying data.



3.2 Creating Pie Charts
Pie charts are a convenient way to visualize data if the categories that divide the data are not that numerous, like 10 or less. Pie charts apply to categorical variables (either ordinal or nominal). In most cases pie charts are not appropriate for numerical variables since there usually would be too many different numbers for that type of variable.
Example: Suppose a survey was done among 1000 adults about their job situations, with the following results:
	No Job
	One Job
	More than one Job

	122
	536
	342


Use a Pie chart to represent this data.
Instead of using a table - which may or may not look "pretty" - we need to represent the data in a pie chart. We proceed as follows:
· Start Microsoft Excel
· Enter the above data, using the first three columns and two rows of the spreadsheet. Your spreadsheet should look similar to this:
[image: http://www.mathcs.org/statistics/course/Graphs/images/chart-pie-data.jpg]
· Highlight the six cells containing the titles and numbers,click on the "Insert" ribbon and hit the Pie chart wizard:
[image: Excel 2007 Charts]
There are a number of different pie chart types. For now, pick the first type to create a simple 2D pie chart, which will be inserted into your spreadsheet.


· You now have a variety of Design, Layout, and Format options. Experiment to create a pie chart to your liking. I, for one, like this layout:
[image: http://www.mathcs.org/statistics/course/Graphs/images/pie-chart.jpg]
Note that Excel has automatically converted the raw data into percentages of the total and rounded it properly. In other words the figure for "one job" was converted to
    536 / (122 + 536 + 342) * 100 = 536 / 1000 * 100 = 53.6 %, rounded up to 54%
Practice: If your pie chart does not have a 3D-look, what would you need to do to re-create the chart but this time with a 3D look? Or if you did pick a 3D look originally, now pick a 'flat' design.
[image: http://www.mathcs.org/statistics/course/Graphs/images/pie-chart-2.jpg]
Note: If you move your cursor over the various slices of the pie while inside Microsoft Excel, you will see the total number as well as the number in percent corresponding to that slice. In fact, when you double-click on the pie you can choose the "Data Labels" tab from the "Format Data Series" dialog box to include the numbers in a variety of formats in the graph - try it out now.
Exploding your pie chart: You can also explode your pie chart (which sounds a lot more fun than it is). Simply click on one of the pie slices (not any text, though) and drag it outwards a little - your chart will explode! You can either make one slice move out of the pie or all slides. This is useful to highlight one particular slice. In the example I have also colored that slide green to excentuate it even further by right-clicking on it and selecting "Format Data Series”.

3.3 Creating Bar Charts
Bar charts are applicable to categorical variables, just as pie charts, but they can accommodate more categories than pie charts.
Example: A survey was done to find the number of workers employed by major foreign investors.
	Great Britain
	Germany
	Japan
	Netherlands
	Ireland

	6500
	1450
	1200
	200
	138


Construct a bar char representing this data.
This time we need to represent the data as a bar chart, with vertical bars, or columns, representing the number of workers employed by major foreign investors (in some unit of measurement):
· Start Microsoft Excel
· Enter the above data, using the first five columns and two rows of the spreadsheet. Do not worry about the fact that you may not be able to see the entire country names in the first row.
· Highlight the ten cells containing the titles and numbers and use the "Insert" ribbon to insert a bar chart. As with the pie chart, there are many different styles you could pick. I went with "Clustered Horizontal Cylinder", which gave me:
[image: Horizontal Bar Chart]
Nice, but not great (I don't like that the bars go horizontally, it would be nicer if they went vertically instead), so we will want improve on this a little:
· double-click on the existing chart to bring up its Design ribbon
[image: Bar Chart Design Ribbon]
· Click on the Change Chart Type and select the Column template and pick 3D Clustered Column
· Select the 'Series 1' label on the chart and remove it by hitting Delete
· Switch to the Layout ribbon and add a Chart Title
· Right-click on the y-axis, pick Format Axis and make sure that the range on the y-axis goes from 0 to 6800
This should be the result of our reformatting effort so far:
[image: Vertical Bar Chart]

Try this: To accentuate Germany, say, change the color of Germany's vertical bar to, say, green (right click on the bar, etc.). Changing colors is but one trick to draw attention to one particular feature of your chart. In fact, you can use such techniques to highlight some data and downplay others without actually changing the data. We will explore this further in a homework assignment.


3.4 Frequency Histogram
The previous chart types work well for categorical data since there are usually a limited amount of categories. The most important type of graphical data representation for numerical data is a Frequency Histogram, or histogram for short. Let's consider an example:
Example: In an anonymous survey of students in a stats course (like the one you filled out at the beginning of the class) you were asked your sex, male or female. Here are the responses received:
2, 1, 2, 1, 2, 1, 2, 1, 2, 1, 1, 1, 2, 1, 1, 2, 1, 2, 2, 2, 2, 2, 2, 2, 2, 1, 1, 2, 2, 2, 2, 2, 2, 1, 2, 1, 2, 2, 1
where 1 = male and 2 = female.
First, as a quick review, is this a numeric, nominal, or ordinal variable - I hope you're thinking "nominal" and you don't get fooled by the minor detail that the values are all numbers (which are merely code for the categories).
Second, a usual bar chart (or pie chart) would not work well. I am not really interested in the fact that some responses were 1, others were 2. Instead I want to know how many 1's (men) andhow many 2's (women) there are, or in the frequencies of the various responses. In this case I could (relatively) easily count the values manually to find the following frequencies:
	
	Frequency

	Male (1)
	15

	Female (2)
	24

	Totals
	39


This frequency table tells me, for example, that more women than men are taking this stats class. Also, if I meet a person from this class completely at random on the street, there is a "15 in 39" chance it is a man and a "24 in 39" chance it's a woman (we'll do some probability theory later but this should make common sense).
In the above example we could generate our frequency table manually easy enough, and we could subsequently use that table to generate an appropriate chart. But if we have hundreds or thousands or responses, we would like to use Excel to generate the frequency table and associated chart.  Also, it may not be completely clear in which category responses fall. especially if the variables are numeric. As usual, Excel will provide a relatively convenient method for us to automate our calculations.
Example: Many communities add fluoride to water to prevent tooth decay. In a 25 day period, these levels of fluoride were measured:
75, 86, 84, 85, 97, 94, 89, 84, 83, 89, 88, 78, 77, 76, 82, 72, 92, 105, 94, 83, 81, 85, 97, 93, 79
There are too many numbers for pie or bar chart, and in fact we are not interested in the actual numbers as much as we are interested in the frequency with which they occur. Hence, we want to group them into categories, and then graph the frequency counts of these categories instead of the original numbers.
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram-data.gif]
As mentioned, we will use Excel to create such a frequency histogram. This time, however, we will not use the Chart Wizard but instead our first procedure from the Analysis ToolPak.
· Start Excel and enter the above numbers, all in one column. You do not need to enter a title or anything else, just the numbers in one column. Note that the picture only shows the first and last few numbers, but you should, of course, enter all numbers in the first column.
· Now bring up the "Data Analysis ..." dialog (remember, it is available on the "Data" ribbon). If you do not see this item, you must first install the "Analysis Pak", as described previously. Anyhow, a dialog box similar to the following will appear
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram1.jpg]
· Highlight the entry "Histogram", as in the above picture, then click on "OK".


The "Histogram" tool is appropriate to compute frequency tables and charts for numeric variables. You could continue reading the instructions or check out the video if you prefer:

To continue with the instructions, you need to enter the options for a (frequency) histogram next, including the location of the data to be used and the categories that you want to use.
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram2.jpg]
The various options in this dialog box need further explanation (click on "Help" inside that dialog box):

	Input Range
	Enter the reference for the range of data you want to analyze.

	Bin Range: [optional]
	Enter the cell reference to a range that contains an optional set of boundary values that define bin ranges. These values should be in ascending order. Excel counts the number of data points between the current bin number and the adjoining higher bin, if any. A number is counted in a particular bin if it is equal to or less than the bin number down to the last bin. All values below the first bin value are counted together, as are the values above the last bin value. If you omit the bin range, Excel creates a set of evenly distributed bins between the data's minimum and maximum values.

	Labels
	Check this if the first row or column of your input range contains labels. Clear this check box if your input range has no labels; Excel generates appropriate data labels for the output table.

	Output Range:
	Enter the reference for the upper-left cell of the output table. Excel automatically determines the size of the output area and displays a message if the output table will replace existing data.

	New Worksheet Ply
	Click to insert a new worksheet in the current workbook and paste the results starting at cell A1 of the new worksheet. To name the new worksheet, type a name in the box.

	New Workbook
	Click to create a new workbook and paste the results on a new worksheet in the new workbook.

	Pareto (sorted histogram)
	Select to present data in the output table in descending order of frequency. If this check box is cleared, Excel presents the data in ascending order and omits the three rightmost columns that contain the sorted data.

	Cumulative Percentage
	Select to generate an output table column for cumulative percentages and to include a cumulative percentage line in the histogram chart. Clear to omit the cumulative percentages.

	Chart Output
	Select to generate an embedded histogram chart with the output table.



There are a lot of options, perhaps confusing ones, but the only mandatory option is the input range. In our case, we need to enter the data range (the cells containing the data) and we need to make sure that the option "Chart Output" is selected. Excel provides an easy method to select the data range (or many other cell ranges within dialog boxes).
In the above dialog box, you will notice three "cell selector" icons [image: http://www.mathcs.org/statistics/course/Graphs/images/histogram3.gif](for the "Input Range", the "Bin Range", and the "Output Range")
In our case, you should click on the cell selector icon  [image: http://www.mathcs.org/statistics/course/Graphs/images/histogram3.gif] next to the "Input Range". The "Histogram" dialog box will temporarily shrink and you can now use the mouse and/or cursor keys to select the appropriate cells by highlighting them:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram4.gif]
When you have selected the appropriate cells, click the "Return" icon in the small "Histogram" dialog to return to the original "Histogram" dialog box. You should now see the text "$A$1:$A$25" as "Input Range".
Next, we should determine the "bins" that in turn will determine the category boundaries. However, for a "quick" histogram, we do not need to fill in the bin range and instead Excel will compute the highest and lowest data point and subdivide the values automatically into evenly divided categories. In other words, for this particular example we will leave the "Bin Range" empty (we will provide a second example where we manually determine the categories, or bins).
We can now choose to display a frequency table only, or a frequency table together with a histogram chart, simply by selecting or de-selecting "Chart Output". We have done that (i.e. frequency table plus chart), and the output looks similar to the following:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram5.gif]
As usual, we can now customize our chart by double-clicking on its components to replace the various titles by more meaningful names, and removing the "Frequency" label. Out final histogram might look like this:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram6.gif]
We have changed the color of the frequency bars to red, the background to light brown, and we have replaced the various titles by more appropriate names.
In this example Excel determined the categories for our numeric variable (the "bins") automatically. Excel decided:
· category 1 goes from 0 to 72 and includes 1 measurement
· category 2 goes from 72 to 78.6 and includes 4 measurements
· category 3 goes from 78.6 to 85.2 and includes 9 measurements
· category, 4 goes hour 85.2 to 91.8 and includes 4 measurements 
· category 5 goes from 91.8 to 98.4 and includes 6 measurements 
· category 6 includes everything above 98.4 and includes 1 measurement 
This means, for example, that on 9 of the 25 days measured the pollution was between 78.6 and 85.2.
By the way, I hope you notice that this description of the categories leaves room for for interpretation.  Where, for example, would a value go that is right on the border between two bins? For example, would a measurement of 78.6 fall into category 2 or  in  3? What do you think will Excel decide in a borderline case such as this? As a hint, look at the last two categories and generalize from there.
Practice: Open the Excel spreadsheet linked below. It shows the age of respondents to a survey.  Generate a frequency histogram and determine if the variable is homogeneous or heterogeneous. Use the default number of categories Excel comes up with.
[image: http://www.mathcs.org/statistics/course/00-icons/excel.gif]numeric survey results
Excel's histogram tool works well for numeric variables, but in case the variable is not numeric another procedure works better and we will outline that in a subsequent section.  In our next example, however, we assume we do have a numeric variable and we are interested in defining the categories (aka bins) ourselves. This is usually not necessary but is useful, particularly for large data sets. but if you are pressed for time you may skip this portion and perhaps mark it for review at a later time. As a reward for those not adverse to a challange, you'll get to analyze the salaries of Major League Baseball players over the past decades and the end of this section; interesting stuff indeed!
Please note that Excel's default categories for numeric variables usually (but not always) work fine, but it is sometimes necessary to have a specific number of categories. The procedure to define your own categories is perhaps a little more complicated than our previous procedure but - we will look at it as an opportunity, not a difficulty ...
Example: A study was done that measured heights of widgets produced in a certain factory. Here are the results:
3, 2, 5, 1, 4, 11, 3, 8, 23, 2, 6, 17, 5, 12, 35, 3, 8, 23, 6, 14, 41, 7, 16, 47, 8, 18, 53, 10, 22, 65, 9, 20, 59
Construct a frequency table with associated chart using five categories and again using eight categories.
As usual, start  Excel and enter the above data, all numbers in one column.
Before we can generate the histogram using the "Data Analysis ..." menu entry we need to perform a few calculations so that we get the desired number of categories. In the previous example Excel handled the category selection automatically, but this time we want to specify bounds so that we get exactly 5 (or 8) categories. Here is what we have to do:
1. Decide on the number of categories you want (usually between 5 and 10)
2. Compute the minimum (smallest) value of our data
3. Compute the maximum (largest) value of our data
4. Compute the range of our data, i.e. range = maximum - minimum
5. Compute the width of each category, i.e. width = range / (number of categories)
6. Find the separation points for each category, given by:
 
· minimum + 1 * width
· minimum + 2 * width
·    ...   
· minimum + (n-1) * width
where n is the number of categories we want.
This could be done easily by hand, but Excel provides formulas for doing this as well. In fact, a by-hand computation (with the help of a simple calculator is probably easier - and you should most definitely do that - but since we are committed to Excel, I'll show how to do it with Excel formulas. 
In the picture below, we show the results of these computations, together with the formulas that yield the various numbers:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram7.gif]
The formulas, displayed in blue on light brown background, are actually entered in place of the numbers shown in the above picture, i.e. you will not see those formulas in the actual Excel spreadsheet. To recall how to enter formulas like these, please refer to a previous section.
Note that there are four category breakpoints, which will result in five categories:
· numbers below 13.8, including 13.8
· numbers bigger than 13.8 and less than or equal to 26.6
· numbers bigger than 26.6 and less than or equal to 39.4
· numbers bigger than 39.4 and less than or equal to 52.2
· numbers bigger than 52.2
Now we proceed just as before, but this time we will select the cells D8 to D11 as "Bin Range" in addition to the previous example. In other words:
1. Select "Data Analysis ..." from the "Tools" menu
2. Select "Histogram" and click on "OK"
3. Select as "Input Range" the cells containing the data numbers, in our example A1 to A33
4. Select as "Bin Range" the cells containing the numbers in D8 to D11
5. Select the option "Chart Output" and, by necessity (as mentioned above), also "New Workbook" for the output
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram8.gif]
Click on "OK" to produce a frequency chart similar to this one:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram9.gif]
It is now very simply to create a frequency table and chart with 8 (or any other number of) categories: in the original spreadsheet, simply change the number of categories from 5 to 8 (which will change the "Width" as well as the current category cutoff points) and add 3 additional cutoff points (using the appropriate formulas):
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram10.gif]
Select again "Histograms" from the "Data Analysis ..." entry of the "Tools" menu, but make sure that the "Bin Range" now contains the new cutoff points just computed. The final result will look similar to this:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram11.gif]
Of course we could again change the corresponding titles, colors, ranges, etc. by double-clicking on them. By the way, do you think this is a homogeneous or heterogeneous distribution - I hope you're thinking that most values clump around the category 9, which would indicate it is - if you had to decide - homogeneous. And note that you would arrive at the same conclusion if you had considered the previous histogram with 5 bins.
Practice: The next Excel spreadsheet contains data for salaries of Major League Baseball player from 1988 to 2011. Open the data files and create a histogram for the salary variable. Think about whether it is actually a good idea to create this histogram. Perhaps there is some problem with this, some information that you don't quite capture if you create a histogram for the entire data?
[image: http://www.mathcs.org/statistics/course/00-icons/excel.gif]major league baseball salaries



3.5. Bending the Rules
Using graphical data representation provides a great opportunity to visualize data so that it conveys a particular point of view. This is not cheating, it is simply using some visual aides to make your data appear to support one particular point of view over another without actually changing the data.
Here is, for example, a table of how much different states spend per students in dollars in 1980:
	State
	$ per Student
	State
	$ per Student

	Arkansas
	$1219
	Idaho
	$1345

	Mississippi
	$1189
	New Jersey<
	$2576

	North Dakota
	$1607
	Washington
	$2079


If we insert a vertical bar chart as described in a previous section without picking any options, it might look similar to the following:
[image: Default bar chart]
It is easy to see that New Jersey spends the most per student, about twice as much as states like Arkansas or Mississippi. The difference between NJ and AK is pretty clear.


Now suppose we want to give a presentation in which the state of Arkansas looks reasonably good as compared to the state of New Jersey. We could create a bar char that minimizes the differences in state spending by using a particularly "large" scale on the y-axis:
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram-special-1.jpg]
We are also de-emphasizing the empty space that results in choosing a large y-scale by placing the chart title into that area. In this chart it is still clear that NJ spends the most per student - after all, we cannot change the actual data - but the difference does not look quite so stark any more. As another option, we could remove the vertical gridlines to make it harder to see exactly how much money the different states actually spend.
Now let's try the opposite: we want to give a presentation in which the state of Arkansas looks very bad as compared to the state of New Jersey. Thus, we pick a scale on the y-axis that makes sure that the difference between Arkansas and New Jersey appears as large as possible. In particular, we choose a y-scale that starts at 1000 and ends at 2400, instead of more standard values such as 0 to, say, 3000.
[image: http://www.mathcs.org/statistics/course/Graphs/images/histogram-special-2.jpg]
We also picked an "aggressive" color (red) for the Arkansas figure and a "calm" color (green) for New Jersey, emphasizing the fact that we want to represent Arkansas as "bad" and New Jersey as "good". In this chart AK looks pretty bad compared to NJ - in fact, it seems as if NJ spends many times more money per student than AK - but w have not changed the actual data values.
All three charts represent the same data and they are perfectly valid. Yet visually they tell different stories. There are many other tricks that are used frequently to represent data in such as way as to support one particular point of view without outright misrepresenting reality.
Exercise: Support you have some data showing the cases of H1N1 flue infections per region as follows:
· Region 01 - Boston: 215
· Region 02 - New York: 229
· Region 03 - Philadelphia: 193
· Region 04 - Atlanta: 301
· Region 05 - Chicago: 1788
· Region 06 - Dallas: 734
· Region 07 - Kansas City: 164
· Region 08 - Denver: 175
· Region 09 - San Francisco: 1080
· Region 10 - Seattle: 420
If you were a health official in Dallas, you might want to use this data to try to get people in your region to vaccinate against the H1N1 flue. Thus, you are trying to create a chart that emphasizes the number of cases in Dallas versus the other regions so that your citizens are motivated to get vaccinated. Here are a few suggestions:

	[image: h1n1 a]
	[image: h1n1 b]

[image: h1n1 c]


Which of these charts do you like the best? Create your own chart to emphesize the figure in "Region 06 - Dallas".
Try this: Check your local newspaper or online news source to find some charts. See if these charts try to promote any particular point of view or if they are relatively neutral.



3.6. Frequency Charts for Categorical Variables
Often one would like to know the frequency of occurrence of values for a variable in percent. This is similar to a frequency histogram we studies earlier, but a histogram only applies to numerical variables, while the procedure outlines in this section will apply to categoricalvariables. Unfortunately the procedure is somewhat lengthy, but with a little bit of practice it should not be too bad.
Example: A survey was conducted in the summer of 2004, asking several students in a statistics course a number of questions about their background and musical taste. The data can be found by clicking on the link below. Display a bar chart for the race of the students. In other words, compute how many of the students are white, black, hispanic, etc. and display those figures in a bar chart.
Here is the spreadsheet that contains the results of this survey:
[image: http://www.mathcs.org/statistics/course/00-icons/excel.jpg]Student Survey
Loading this data into Excel, we see that there is one column of interest, entitled "Race". However, that column represents a categorical variable (ordinal or nominal?) so we can not compute a frequency histogram. Also, the values are not numeric so we can't ask Excel to automatically add up all the "hispanics" (for example).
[image: Spreadsheet Data]
But since that column does contain the data we want to display, we need to learn a new procedure for handling categorical data. The procedure should automatically count the frequencies of the various races and present those counts in a bar chart.
Before we figure out how Excel can do this automatically let's simply do it by hand. Inspecting the data we see that there are 5 categories, White, Black, Hispanic, Pacific Islander, and Other. We type these categories into an empty part of the Excel spreadsheet and manually count how many people in each category are contained in our data. We add these counts, or frequencies, next to each category manually:
[image: Spreadsheet Data]
Now it should be easy to create the appropriate bar chart - make sure to do it, it works just as described in the previous section on creating simple bar charts.
Our manual procedure barely worked because we did not have that much data. For large data sets we need to figure out an automatic procedure to create a table of frequencies and the associated bar chart. Fortunately, Excel has just such a procedure, called a Pivot Table. The Pivot tool is found as the first button of the "Insert" ribbon. It looks slightly different depending on the version of Excel but the differences are pretty minor and you should be able to figure it out. For detailed assistance - if you are using Excel 2007 - you could try this helpful video.
The Pivot tool is actually a lot more flexible than we will need in our course, but it will for sure create the type of tables that we will be interested in. We will, in fact, see that tool again subsequent sections.
· Load the above spreadsheet into Excel and click anywhere outside the data area, for example below the last row of data. If you don't put the cursor into a free cell, the Pivot tool will be disabled.
· Select "Insert" -> "Pivot Table" and choose the entire data table for the Inpout/Range field, using the by now familiar range selector. Make sure to pick the entire data table, including the first row containing labels.
· You can choose to put the resulting pivot table into a new spreadsheet, but for now we can just leave it at the bottom of the data range.
· Click "Okay" to generate the pivot table (which will initially be empty)
You will see a "potential frequency/percentage table" containing labels such as "Drop Row Field Here", "Drop Column Fields Here", etc., but no data values are yet contained in the table. There will also be a window called "Field List" containing the available variables from your data, in our case "ID", "Sex", "Weight", "Height", "Race", etc. You can "drag-and-drop" these variables to the various slots in the table to create a variety of useful tables for data analysis.
[image: Pivot Table]
· Drag the variable "Race" from the field list into the "Drop Row Fields" area of the table. Your table will adjust, showing you all available "Race" categories but as for now no frequencies (counts) yet.
· Next, again drag the variable "Race" from the field list, but this time drag it to the "Drop Data" or "Value" area in the middle.
You will finally see the counts of how many occurrences fell inside each race category, which of course will turn out similar to the one we created manually before, except this time it includes the "blank" category (and the order may be different.
For extra credit, see if you can eliminate the "blank" response row. Hint: maybe you can find a drop-down menu somewhere where you can 'uncheck' unwanted categories. Also, when you double-click the "Count of race" label in the table you can specify exactly what type of counts should be shown and in which way it should be formatted. Try for example to get your counts to appear as percent of the overall total.
· You can now create the bar chart as usual, including or excluding the blank response as you see fit. But it is even easier: if you position your cursor inside the "pivot" table, an "Analyze" ribbon will appear as one of the "Pivot Tools" - it will contain a "Pivot Chart" button, use that to create a chart.
In subsequent sections we'll revisit the Pivot Table tool and investigate additional options and possibilities. If you have problems with the Pivot tool so far, you might want to check out the following video:

Exercise: Please practice using the same data set and create:
1. a bar chart representing the number of males and females in the survey
2. a bar chart representing the number of vegetarians in the survey
3. For review, create a histogram for "weight". The obstacle here will be that there is one (or more) blank data points for this variable.
4. The more review, create a histogram for "height". In this case you will notice that one guy entered 5 as height, which does not make sense compared to all the other data points. What should you do with this exceptional value?
You should of course use the Pivot tool, not count the frequencies manually. For your reference, the charts for the first two questions are as follows:
[image: Pivot Table]
The last two questions require a good old histogram, which we have covered before. The apparent problems with this will be discussed in homework.
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